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A Step by Step Guide for Tenderers    
 



Introduction 
 
The Masterbill eTender Program is a Bill of Quantities electronic tendering system for 
Surveyors, Engineers and Estimators.  It is not an estimating system, but it can link to 
estimating systems.  It is a true 32-bit program written for the Windows 9x/ NT/XP 
environment and is therefore capable of communicating with Microsoft Windows products.   
 
Guide conventions 
This guide has been put together to enable the new user to work their way though the 
eTendering process step by step. 
 
Menu names 
Main menu bar names start with a capital letter, are printed in bold type and underlined.  For 
example: File.  
Sub menu names start with a capital letter and are printed in bold type.  For example: Save 
 
Dialogue box names 
Dialogue box names begin with uppercase letters.  For example: Print Setup 
 
Key combinations 
Key combinations joined with a plus sign (e.g. Ctrl+N) mean that you press and hold the first 
key and then press the second key. 
 
Mouse 
Click   = click once on the left button 
Right click  = click once on the right button 
Double click = two clicks on the left button 
 
About eTender 
eTender allows the user to import and export electronic tendering information using XML data 
transfers either by the Internet or by disk. Bills of Quantities can be imported directly from 
XML files, which may have been e-mailed or downloaded from a QS-Website. 
Once the Bill of Quantities has been imported it may be priced and then the prices can be 
sent back to the originator using the XML export facilities.  
 
The Bill of Quantities may also be packaged up and sent out to other sub-contractors who are 
using the e-Tender application, they in turn can send back the prices for you to include in 
your priced Bill of Quantities.  eTender does allow the use of industry standard CITE files but 
in the case of importing data from Masterbill’s own software XML is the better option. 
 

XML Explained 
XML stands for eXtensible Mark-up Language and is a data language that describes the 
contents of the data held within a file. The eTender program uses XML as a data transfer 
format. So if you wish to receive or send data from the eTender program you will either save 
the data to an XML file on disk or transmit the file across the Internet using email. 
 
 
 
 
 
 



Step 1: Installing the eTender Software 
Place the eTender CD in the PC drive. 
It may auto run. 
 
If not click on the Start button and click Run 
A Run dialog opens 

•  Click the Browse button and navigate to your CD drive 

 
 
 

•  Double click on eTender in the Browse dialog 

 
 
 

•  Select Setup.exe in the next dialog 

 
 
 
You will then see it selected in the lower ‘File name’ list box 

 
 
 

•  Click Open and you will now see it in the Run dialog 

 
•  Click OK and the install will begin. 

 
 
 



A Registration Procedure dialog containing a unique code appears 

 
The top part of the screen will display this unique code.  This code is different every time you 
run the install.  So each install is unique to the PC in question.  Installing again on another PR 
will constitute another licence. 
 
Follow the on screen instructions, normally you will ring Masterbill to purchase the eTender 
software, and quote the Unique Code to obtain a Pass Code. 
 
Type the pass code into the text box and click OK.   
The install will now continue.  

•  Click Next to accept the options 
When you reach the final screen click Finish. 

 
 
eTender will now be installed under Masterbill in the ‘All Program’ List. 

 
Different versions of Windows may have a slightly different screen but eTender can be 
opened in the normal way. 
 
On starting, a screen opens with an Explorer on the left and a Bill View screen on the right. 

 
 
Bills can be imported and viewed and priced in this view screen. 
 
As well as Menu items there are a number of shortcut buttons along the top. 
There are also help files under the Help menu 

This number will be 
different on every 

install process 



e-Tender toolbar explained. 

 
 

 New e-Tender Project. 

 New Construction Directory Project. 

 New Package. 

 Open Selected Bill or Package. 

 Connect to Construction Directory. 

 Disconnect from Construction Directory. 

 Print Bill of Quantities. 

 Print Preview the Bill of Quantities. 

 Import a document from the Construction Directory. 

 Export prices back to the Construction Directory. 

 Export to an XML file. 

 Import from an XML file. 



Step 2: Importing the Tender Documents 
BQ’s from Masterbill’s own billing or estimating systems can be imported via XML.  Data 
from other eTender users can also be imported using XML 

Import a BQ via XML 
To import a Bill of Quantities from an XML file you do not need to select a project in the 
project tree.  If importing for the first time the project as well as the bill will be set up. 

•  Click on the XML import icon on the tool bar  
 
A window opens that allows you to select the XML file that you wish to import into the 
selected project.  

 
It is a normal Windows dialog.  Navigate to the location of the file.  Highlight the XML file 
and… 

•  Click on Open. 
 
If the XML file contains a project name that is unique to your project tree then a new project 
will be added and the Bill of Quantities will be added to this project. The Bill of Quantities will 
automatically be opened and the first page shown in the bill view. 

 
 
The left hand Explorer window may not refresh.  Close down the programme and restart.  
You will see the new bill in the tree. 

•  Click on the “+” icon to extend the eTender tree. 
•  Click on the  “-” icon to contract it. 



 
 
If a bill has already been imported to your project, subsequent imports of additional bills will 
identify the project and list them in the correct place. You may still need to reopen to refresh 
the screen to view any packages 

•  Click on the project to select it, and click on the right hand open folder button to 
open it 

  
 
Alternatively  
 

•  Right click and select Open  

 
 
 
 
 
Other means of importing data 
For the convenience of some users, eTender can also import data and export prices in CITE 
format (Construction Industry Trading Electronically).  BQ’s can be exported in CITE, e.g. to 
a users own Estimating programme. 
 
CITE is an ASCII text document and most estimating systems can read in a CITE file, but 
many do not export. 
 
However before a bill can be imported in CITE a project must be set up first (note this is not 
necessary if using XML – the XML data will set up the project.) 
 
To start a NEW PROJECT  

•  Click on the File menu item and select New.  

 
•  Select New Project 

 
A window opens to allow you to enter the project properties (see below). 
 
 
 
 
 
 



 
 
 
Once you have filled in the project details and pressed OK the new project will appear in the 
project tree as shown below. 

•  Click on the “+” icon to extend the eTender tree. 
•  Click on the  “ –“ icon to contract it. 

 
 
Users can then select this project and import BQ data into it.   
However remember this is not essential if using XML, if the system detects a new project 
name then it will set up the project at the same time as importing the bill. 



Step 3:  Creating a package 
Once a bill has been imported items can be priced, but they can also be selected and saved 
to a Subcontractor package. 

 

To create a new package select the project in the project tree that you wish the package to 
created in.  
Select the File | New menu option. 
From the sub menu select New Subcontract Package.  
Alternatively  

•  Click on the New Package icon in the tool bar. 

 
A window will open that will allow you to enter the package details. 

 
 
Once set up, the package can be seen in the Tree. 

 
When a package is open the bill view screen is split into two.  
The left hand side is the bill of quantities that you are working from and on the right hand 
side is the package that you are adding items to.  
 

 
 
Transfer Items 
To add the items to the package double click on the items in the bill on the left hand side and 
they will be transferred to the package on the right hand side. 
 



Step 4: Exporting a package to XML file 
In the project tree select the package that you wish to export.  

•  Select the File menu option and  
•  Select XML Data Exchange.  

From the sub menu  
•  Select Export Subcontract Package.  

A window will open that will allow you to enter the name for the XML file that the package 
will be exported to. 
 
Enter the name of the file and then click on the Open button this will save the file to the 
specified location.  
This file can then be emailed to your sub contractors or if you have a QS-Web site you can 
upload this file onto you project area within the site. 
  
Subcontract packages can be simply printed and posted in the normal manner. 
Open the Package then  

•  Click File | Print  
 
 

Step 5: Pricing the BQ 
The first step in pricing a bill is to select a tender that the prices will be stored against.  

•  Click on the View menu and select Tenders  
A window will open that allows you to enter and select tenders as shown below.  
Here you can enter your own Company name or any text to identify your own tender as 
opposed to any Subcontract package windows that you may open.   
You can also enter subcontractor names here as well.  See later. 
 

 
 
Once a tender has been selected it will be shown as the heading for the rate column on the 
bill view. 

  



The prices are simply entered in the rate column. 

 
 
Type in the desired rate and hit the Down Arrow key to move down to the next item. 
The Page Down key will move on to another page. 
Alternatively 

•  Click on the scroll (or ‘VCR’) arrows to change pages. 

   
The inner arrows move one page at a time. The outer ones take to straight to the beginning 
or the end of the document. 
 
 
 
The price type can then be selected from the drop down list of preset price types.  
Once the price type has been selected the extension will change to reflect the price type. 

 
 
Note: The default price type is Unit Rate. 
 

 



Step 6: Incorporating Rates from a Package 
Prices can be manually entered into a selected subcontract if necessary.  This is done as per 
Step 5. 

However the process can be done electronically. 

Importing prices from an XML file 
You may have packaged up some of the items and sent them off to subcontractors who are 
also using an e-Tender enabled application.  
(See the section on Packages) 
The prices for these items may have been returned to you as an XML file.  
To import the prices from this file,  

•  Select the menu item XML Data Exchange and then  
•  Select Import Prices.  

This will open a window that will allow you to select the XML file that has been sent to you. 
Highlight this file and click on open. Another window will open that will allow you to select a 
tender.  

 
Once a tender has been selected you will be prompted to add a name of the subcontractor to 
the List of Tenders. Just type in a number and a name. 

 
The prices will be imported from the file into the package and stored under the selected 
tender.  For these prices to be stored against the named tender the left hand box must be 
ticked. 

 
 
The explorer screen may not refresh properly and you may need to reopen the programme. 

 

Importing prices from a package 
Once prices from possibly several tenderers have been stored for a package the selected 
subcontract tender can be imported into the bill. 
 
In the project tree select the bill of quantities that you wish to import the package prices into.  

 
Then open this bill by  

•  Right clicking and then Clicking Open 
or 



•  Selecting the Open icon on the tool bar. 

 
Then, 

•  Right click on the bill view and a sub menu will be opened.  
From this menu  

•  Select Import prices from package.  
A new window will open that will enable you to select a tender from one of the packages 
within this project. 
As you can see below each project may contain several packages and each package may list 
several tenders. 

 
 
Select the tender within the package that you wish to import the prices from. 
You can add an uplift percentage adjustment to those prices.  

 

NOTE 
The prices that you import will overwrite any existing prices for those items in the selected 
tender in the open Bill of Quantities. 
 
 



Step 7: Returning tender Documents 
The final prices can be returned electronically.  Only the prices will be imported into the 
target application.  

Exporting the prices to an XML File 
In the project tree select the bill that you wish to export the prices from. 
Next … 

•  Select the menu item XML Data Exchange  
and then… 

•  Select Export Prices.  
Again this will open a new window that will allow you to enter the name of the XML file that 
you will be exporting the prices to.   
 
Enter a name for the file and click on open and the file will be saved to your specified 
location.  
 
This file can then be emailed back to the originator of the bill.  
If you downloaded the file from a QS-Website you will need to return to that site and upload 
this file back to the site. 
 
 
 
 
 
 
 
 
 
 
 


